Please note that Cypress is an Infineon Technologies Company.
The document following this cover page is marked as “Cypress” document as this is the
company that originally developed the product. Please note that Infineon will continue
to offer the product to new and existing customers as part of the Infineon product
portfolio.
Continuity of document content
The fact that Infineon offers the following product as part of the Infineon product
portfolio does not lead to any changes to this document. Future revisions will occur
when appropriate, and any changes will be set out on the document history page.
Continuity of ordering part numbers
Infineon continues to support existing part numbers. Please continue to use the
ordering part numbers listed in the datasheet for ordering.

www.infineon.com
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ModusToolbox® 2.3 Tools Package
Release Notes
Production Release
Overview
ModusToolbox software is a set of tools that enable you to integrate Cypress devices into your existing
development methodology. ModusToolbox software consists of various libraries and middleware on
GitHub, as well as an IDE and tools package installed on your computer. For more details about what is
included with ModusToolbox software, refer to the ModusToolbox User Guide.
This ModusToolbox 2.3 tools package is a complete release. It includes the latest features from all
previous releases, including patches. This release does not replace any existing installed releases; it
installs alongside them. If you have more than one release installed, refer to the ModusToolbox
Installation Guide, Product Versioning section.
This document describes the features and known limitations for the ModusToolbox software provided as
part of the ModusToolbox 2.3 tools package included with the installer.
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What’s Changed
This release of the ModusToolbox tools package includes the following updates and features:

New EZ-PD Configurator
The Easy Power Delivery (EZ-PD) Configurator provides a user-friendly tool for selecting the features and
configuring parameters of the PDStack middleware.

Updated KitProg3 Firmware
The KitProg3 firmware version was updated to deliver GPIO bridging support, along with several bug
fixes. Refer to the KitProg3 User Guide for details on how to update your kit.

Integrated Third Party IDE Support
For previous versions of ModusToolbox, you could export applications to other IDEs. However, this was
only possible through the command line. With this release, the Project Creator tool now includes an
option to specify one of several third-party IDEs.

You can still use the command line if you prefer. Either export option generates the appropriate IDE
support files and settings.

Third Party IDE Secure Device Support
The commands to export ModusToolbox applications to IAR EW-ARM and Arm MDK have been updated
to populate post-build entries in the generated files with secure tools command(s).
Note The Eclipse IDE for ModusToolbox and VS Code already include this support.
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Improved Library Support and Control
In this release, we are now locking the library versions used in your application to the latest release tag
available, so that you don’t have to worry about locking versions down by yourself. To learn more about
how our library versioning works, review the ModusToolbox User Guide Product Versioning section. We
also notify you about the updates available for a given library in the Library Manager. Plus, we’ve made
the default BSP location to be local by default. However, this behavior is also controlled via the manifest,
which allows you to change the BSP for a given application without worrying that the changes will
propagate to other applications. You can still make the BSP shared using the Library Manager.

Updated BSP Creation and Update Processes
We have removed the option to change the device or companion device from the Device Configurator.
Instead, we have added the command make update_bsp for you to be able to change the primary device
via the command line. Contact support for details about updating the companion device.

Eclipse Update and macOS Big Sur Support
All ModusToolbox tools have been validated to be compatible with macOS Big Sur. As a part of that, we
have transitioned to a newer version (4.17) of the Eclipse IDE included in the ModusToolbox Tools
package.

Windows Multi-User Installation Support
ModusToolbox 2.3 installation on Windows has been updated to allow a one-time, admin-enabled
installation of the pre-requisite software and drivers, as well as any number of nonprivileged installations
of the tools (in the user’s space). This allows multiple users of the same machine to use ModusToolbox
and also share the same installation among the multiple users on the same Windows machine.

Update Quick Panel Performance
The Quick Panel has been updated to improve response time when switching between different projects
in the Project Explorer.

Project Creation / Library Management Message Improvements
Various messages in the Project Creator and Library Manager tools have been updated to provide a more
user-friendly experience, including:
◼

Errors, warnings, and success messages are now color-coded.

◼

Various inaccurate statements have been corrected.

Removed Power Estimator Tool
For this release, we have temporarily removed the Power Estimator (CyPE) tool. We plan to improve it for
a future release. If needed, you can use the tool from a previous release of ModusToolbox.
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What’s Included
This release includes the following tools and versions:
Tool Name

Current Release

Previous Release (Patch)

Eclipse IDE for ModusToolbox

2.3.0

2.2.0

Bluetooth Configurator

2.30

2.20

CapSense®

3.15

3.10 (3.11 patch)

CapSense Tuner

3.15

3.10 (3.11 patch)

Configurator Backend CLI

2.30

2.20 (2.21 patch)

CyMCUElfTool

1.0

Unchanged

Device Configurator

3.0

2.20 (2.21 patch)

Device Firmware Update (DFU) Host Tool

1.40

1.30

EZ-PD Configurator

1.0

N/A

Firmware Loader

3.2.0 [KitProg3 2.20]

3.1.0 [KitProg3 2.10]

GCC

9.3.1

Unchanged

JRE

11.0.10.9 [version 11]

1.8.0_252 [version 8]

Library Manager

1.30.0

1.2.0

GNU make Build System

1.2

1.2

modus-shell

1.20 (Windows)
1.1.0 (Linux/macOS)

1.1.0

OpenOCD (Cypress-specific)

4.2.0

4.1.0

Project Creator

1.30.0

1.2.0

Proxy Helper

1.1.0

Unchanged

Python (for Windows)

3.7.7.3

3.7.7.2

QSPI Configurator

2.30

2.20

Secure Policy Configurator

1.10

(1.0 patch)

Segment LCD Configurator

1.30

1.20 (1.21 patch)

Smart I/O™ Configurator

3.0

2.20 (2.21 patch)

USB Configurator

2.30

2.20

Configurator

Supported Tool Chains
The GCC Arm Embedded toolchain GCC 9.3.1 is installed with the ModusToolbox software. This
toolchain has no use restrictions and does not require license activation (it is distributed under the terms
of the GNU Public License).
Although not installed with ModusToolbox software, the build system also supports these tool chains for
PSoC 6 MCU applications:
◼

Arm compiler v6.11 (Windows and Linux hosts)

◼

IAR Embedded Workbench v8.32 minimum (Windows only)
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Supported Boards
The Cypress boards available for use varies with different releases of BSPs and libraries on GitHub. You
can see the current list of BSPs in the Project Creator tool using the default manifest URL:

Note Additional boards will be made available on an ongoing basis.

Known Issues/Limitations
This section lists the known issues/limitations of this release:

Installation
Problem

Workaround

On common Linux distributions, the serial UART ports
(usually /dev/ttySx or /dev/ttyUSBx devices) belong to
the root user and to the dialout and plugdev groups.
Standard users are not allowed to access these devices.

An easy way to allow the current user access to the
Linux machine's serial ports is by adding the user to the
dialout or plugdev group. This can be done using the
following command:
$sudo usermod -a -G dialout,plugdev $USER

Note For this command to take effect, the user must log
out and then log back in.
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Project Creator
Problem

Workaround

Using the Project Creator Target IDE feature, the
application that was exported to a third-party IDE
doesn’t work in that IDE.

There are limitations to the export process. For example
IAR and µVision are not supported in macOS or Linux.
In other cases, you need to update configuration
settings in the third-party IDE. Refer to the “Export to
IDEs” chapter in the ModusToolbox User Guide for more
details.

In the default case, project creation and library updates
require internet access. In some cases, using a VPN
may adversely affect the time required for these
operations due to a delay in DNS server response times
for external IP addresses such as github.com.

If you experience issues such as this, project creation
and library update times can be improved by disabling
the VPN connection during those operations.

When trying to create a new project you may not see
any BSPs or applications to select, as well as the
following error message:
Unable to open file at
http://github.com/cypresssemiconductorco/mtbsuper-manifest/raw/v2.X/mtb-super-manifest-fv2.xml
Some boards and applications may be missing. Check
the console for a detailed error message.

Verify that you have a network connection and see the
instructions in the Installation problem section above
concerning proxy settings.
This may also be caused by your work environment not
having access to GitHub. Refer to KBA230953 for
details on how to work around this problem.

To determine if this is an issue for you, open a terminal
window and enter "nslookup github.com". If the
response is not immediate, then you may benefit from
disabling your VPN connection.

Proxy
Problem

Workaround

When trying to create a new project, you may see the
following error message:
Unable to open file at
http://github.com/cypresssemiconductorco/mtb-supermanifest/raw/v2.X/mtb-super-manifest.xml.
Some boards and apps may be missing. Check the
logfile for a detailed error message.

This can happen if you are behind a firewall and do not
have your proxy settings configured. You must set your
HTTP_PROXY and HTTPS_PROXY environment
variables or use the Proxy Helper tool from the Settings
menu. You can also find it in:
<install_path>/ModusToolbox/tools_2.3/proxy-helper

In some cases, incorrect proxy settings in the Project
Creator or Library Manager tool can prevent the proxy
server settings from being edited to correct values.

Run the Proxy Helper tool from the Settings menu to
reset the proxy mode to direct. The tool is also located
in:
<install_path>/ModusToolbox/tools_2.3/proxy-helper
For example:
./proxy-helper --config set mode=direct
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Building/Programming/Debugging
Problem

Workaround

The ModusToolbox build process stops at some points,
such as during auto-discovery, and it takes longer than
other times.

This is likely due to anti-virus software scanning various
ModusToolbox directories. To resolve this, change your
anti-virus settings to exclude the following as appropriate
for your installation (where ~ is your home directory):
•
Installation directory (e.g., ~/ModusToolbox/)
•
Settings directory (e.g., ~/.modustoolbox/)
•
Applications directories (e.g., ~/MyExamples/)
•
Eclipse IDE workspace directory (e.g., ~/mtw/)

For PSoC 6A-256K MCU “ERROR: Timeout while
restoring target, core does not stop. (PC = 0x100009FC,
XPSR = 0x01000003, SP = 0x08002EFC)!” can appear
after several executing of Program launch configuration
via Jlink probe by using JTAG interface.

Set Type of Initial Reset and Halt to ‘0’ for Program Jlink
launch configuration in Startup tab

J-Link launch configurations do not work for a PMG1related project.

Use KitProg3 launch configs

While debugging an application built with the GCC
toolchain, some breakpoints cannot be reached as the
application code referenced by the breakpoints is
inlined.
Note The GDB behavior described above has no
functional impact on the application execution.

Switch the optimization level from -Og (default in the
CONFIG=Debug mode) to -O0, by editing the application
Makefile:
CONFIG=Custom
CFLAGS=-O0

Changing the optimization flag to -O0 may impact the
application behavior or memory usage. We recommend
disabling the compiler optimizations only for debugging
purposes.
PSoC 64 Secure MCUs do not support the programming Use SWD interface with PSoC 64 Secure MCUs in
and debugging via JTAG interface. It is because of the
Eclipse and VS Code IDEs
specifics of PSoC 64 MCUs - JTAG pins are configured
after unpredictable amount of time after what causes a
lot of warnings during programming via JTAG.
Unable to acquire PSoC 4 target with J-Link probe if
target is in PROTECTED state. J-Link probe does not
support device acquisition in Test Mode. This prevents
invocation of SROM API making it impossible to reprogram or erase the chip in PROTECTED state.

The workaround is to unprotect/erase the chip using
MiniProg4 or KitProg3 probe.

A “Failed to read memory at <address>” message may
appear in “Memory View” of the Eclipse IDE when
connected via the MiniProg4 probe and try to read
memory from invalid address.

You can safely ignore this error

In VS Code, usability behavior might be observed after a No reliable workaround
Restart operation with PSoC 64 Secure MCUs. For
example, “Failed to launch OpenOCD GDB Server:
Timeout” error may appear when KitProg3 Attach launch
config is running, or if debug session is broken with JLink.
In VS Code, “Exception has occurred” error might
appear when you execute Attach launch configuration.
Such errors started to be visible in VS Code - 1.53.2.
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Problem

Workaround

In VS Code, "Failed to launch undefined GDB Server:
Timeout." error might appear if to launch Debug J-Link
launch configuration with KIT_XMC47_RELAX_V1 after
several 'step over', 'step into' operations during the
previous Debug session what was stopped.

Re-run the launch configuration again after failure

In VS Code, the J-Link launch configuration does not
Step through code to enter the Reset_Handler.
stop at Reset_Handler after ‘Restart’, but at some other
line of code.
For PSoC 6 MCUs, this is associated with any "monitor"
command in GDB. For example, if you press the Restart
button, the Cortex-Debug plugin sends "monitor halt"
and "monitor reset" commands to the GDB causing GDB
to go out-of-sync with the target.
GDB does not know what the "monitor xxx" command
does. It does not expect that "monitor reset" will change
the state of the target.
For XMC and PSoC 4 MCUs, such behavior is caused
by the using "Cortex M0" target for PSoC 4 and “CortexM4” for XMC devices as the workaround for other issue
with Attach in SEGGER SW.
When attempting to Program/Debug with Miniprog4 or
J-Link probes in JTAG mode, the tool displays errors
similar to the following:

These errors are likely caused by the device being in
sleep mode. Open the Device Configurator, and set the
System Idle Power Mode setting to 'Active' to turn off
DeepSleep mode. JTAG is not available in sleep mode.
Alternately, use SWD to acquire the target, and then
switch to JTAG.

If an application includes multiple BSPs that span major
version numbers (for example, v1.x and v2.x) as local
dependencies, there will be build conflicts. This is
because of changes in the names of the BSP's
dependencies.

There are two options:
1) The application can be updated to use the new MTB
flow with the BSPs (and dependencies) marked as
shared.
2) All local BSPs within a application must have the
same major version number. Once the application is
updated to only have a single major version of the
BSP, any of the dependent libraries that were pulled
down by the removed BSP version need to be
removed from the application. This includes
removing any .lib or .mtb files. The problematic
dependencies that must be removed include the
following:
1.x BSP dependencies: psoc6pdl, psoc6hal
2.x BSP dependencies: mtb-pdl, mtb-hal
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Problem

Workaround

KitProg3 and J-Link launch configurations do not work
when you change the build configuration from Debug to
Release or vice-versa. This applies to the Eclipse IDE
for ModusToolbox and Visual Studio (VS) Code.
Launch configurations contain the path to the
executable, and that changes for each build
configuration.

After you change from Debug to Release or vice-versa,
click the “Generate Launches” command in the Quick
Panel.
You can alternately run the following command to create
new launch configurations:
• make eclipse for Eclipse IDE for ModusToolbox
• make vscode for VS Code
Be aware that this option overwrites any changes you
may have made to the configurations.

On macOS for a PSoC 64 or PSoC 6A project, using the Reset the device each time you run the “Attach”
Eclipse IDE for ModusToolbox, the “Attach” launch
configuration.
configuration fails every second time it is used:
•
for an RTOS-based project
•

if “Attach” is launched when the target is halted
on breakpoint

For the Arm Cortex CM4 core, some code in main()
executes before the debugger stops at start of main().
This means that some code executes twice; once before
the debugger stops execution, and again after the
debugger resets the program counter to the start of
main() and you start debugging.

If you observe this issue, and it affects your application,
put a delay loop at the start of main() to allow time for
debugging subsystem initialization. The following code
tests for the presence of the debugger before entering
the delay loop:
int main(void)
{
/* If an active debugger is detected, give
it some time to execute SYSRESETREQ
* otherwise, the application runs before
the debugger is fully operational */
if (CoreDebug->DHCSR &
CoreDebug_DHCSR_C_DEBUGEN_Msk)
{
Cy_SysLib_Delay(400u);
}"

See KBA231071 for details.
Junk characters might be observed in a UART terminal
during programming of the connected kit or after
programming is completed.

Clear UART buffers after programming is completed.

On some occasions, the Eclipse IDE will fail to run
Depending on the steps taken prior to launching a
launch configurations with various errors, such as:
configuration, there are several reasons this may occur.
The easiest way to resolve the issue is to restart Eclipse.
"XXX has encountered a problem. Debug session
already started. Terminate the first one before restarting"
There is a programming error for Cypress platforms that
connect via FTDI on macOS Catalina. The boards
include:
•
CYW920819EVB-02
•
CYW920820EVB-02
•
CYW920719B2Q40EVB-01
•
CYW920721B2EVK-01
•
CYW920721B2EVK-02
•
CYW920721B2EVK-03
•
CYW989820EVB-01
•
CYW920706WCDEVAL

•

This only happens in macOS Catalina 10.15.5 because
of a serial port detection error. The macOS Catalina
FTDI driver is missing the necessary device
identification information.
To resolve this issue, update to macOS Catalina 10.15.6
or newer.

CYW920735Q60EVB-01
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Problem

Workaround

A “JTAG-DP STICKY ERROR” message may appear in
the IDE when connected via the JTAG interface of a
MiniProg4 probe in CMSIS-DAP HID mode.

You can safely ignore this error, or switch the MiniProg4
to CMSIS-DAP bulk mode.

JTAG performance on MiniProg4 may be significantly
slower than SWD.

There is no workaround except using the SWD interface
if JTAG performance is not acceptable.

You must manually reset after programming PSoC 6 kits
when using GDB SEGGER + Jlink + JTAG interface.

Update each of the following Launch Configurations
under the Debugger tab. In the Device Name field,
delete the "_tm" suffix.

•
•

"<app-name> Erase (JLink)"
"<app-name> Program (JLink)"

Starting from KitProg3 v2.10, when KitProg3 is in
CMSIS-DAP Bulk mode, it is not possible to debug and
use USB-I2C/SPI bridging (for example, in the
CapSense Tuner, Bridge Control Panel) at the same
time. This affects Windows OS only. It does not affect
Linux or macOS users.

If you would like to use debug and USB-I2C/SPI bridging
at the same time, there are two possible workarounds:
•
If performance for programming and debug is
not critical, switch KitProg3 to CMSIS-DAP
HID mode via the fw-loader utility. Firmware
Loader is installed with ModusToolbox
software, and is available separately on
GitHub.
•
If you need faster performance for
programming and debug, use the onboard
KitProg3 for programming purposes and
MiniProg4 for bridging purposes or vice versa.
Both devices can be in CMSIS-DAP
bulk mode.
Details are in KBA231025.

Starting from KitProg3 v2.10, in some cases Windows 7
does not recognize the KitProg3 bridge. So the USBI2C/SPI bridge devices are not available in either
CMSIS-DAP HID or CMSIS-DAP bulk mode.

Install a digitally signed driver manually from the
Windows Update Catalog. Follow steps from
KBA231026.

In Linux OS, with KitProg3 in CMSIS-DAP HID mode, a
debug session in ModusToolbox can be destroyed if you
use the Firmware Loader --device-list command
while debugging. This is limitation of hidapi library used
on Linux.
MacOS and Windows OSs are not impacted.

If you have a debug session running, don't use the
firmware loader tool.

KitProg3 v2.10 or later is installed as part of the
ModusToolbox 2.2 or later tools package. This version of
KitProg3 will not work with PSoC Creator 4.3 or
PSoC Programmer 3.28.7.

If you updated your kit to KitProg3 v2.10 and wish to use
the kit with PSoC Creator 4.3 and PSoC Programmer
3.28.7, get a previous version of fw-loader (with an
earlier version of KitProg3) and update the kit. The fwloader tool is available here:
github.com/cypresssemiconductorco/Firmware-loader
If this is not urgent, you can wait for a newer PSoC
Programmer version with support for KitProg3 v2.10,
expected soon.
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Eclipse IDE
Problem

Workaround

Sometimes when importing an application using the
Eclipse IDE, a message displays stating the following:
Unable to add the shared library project at
"<workspace_location>/mtb_shared" to the
workspace. That project is for reference only;
functionality is not affected.

This message can be safely ignored.

For some macOS machines running on M1 processors,
The only solution to this problem at this time is to
the Eclipse IDE may fail to start with a message such as: uninstall and reinstall ModusToolbox.
ModusToolbox quit unexpectedly.
We are investigating this issue for the next release.
The message details also state that the "attachment of
code signature supplement failed."
In the updated Eclipse IDE for this release, the News
tab has been removed. However, it may appear if you
open an older release application in the updated IDE. If
so, it may contain an error message like:
"Unable to access the news site. Please check your
internet connection then click on the button below to
try again."

The web page that provided content to the News tab is
no longer maintained. You can safely ignore the
message about site access.
If you want to remove the News tab from this
workspace, select Window > Perspective > Reset
Perspective...

Some projects that run pre- or post-build scripts, for
example BTSDK or XMC, when imported in the Eclipse
IDE on macOS and Linux fail to build if the project
archive contains executable files.
If an existing project is exported from Eclipse using
File > Export > General > Archive File, and then the
resultant .zip file is imported into another workspace
using File > Import > General > Existing Projects into
Workspace, any files that had the executable
permission bit set in the original project will have the
executable bit stripped in the new imported project.
This can vary from project to project, but can include
executables necessary to the build process, which can
cause the imported project to fail to build, or other
possible side effects depending on what executables
may be in the archive.

Identify what files were executable in the original project
(pre-export) and then manually fix them in the new
imported project with the following terminal command:
chmod +x <filename>

For a ModusToolbox 2.2 application that includes a
This problem has been addressed for version 2.3
shared directory, such as mtb_shared, when you use the applications and it only occurs for version 2.2
Build All command you may see an error such as:
applications with a shared directory.
**** Build of configuration Debug for project To stop this message from occurring, open the
mtb_shared ****
properties dialog for the shared directory (Properties >
make: *** No rule to make target 'all'. Stop.
C/C++ Build) and change the Build command field to
Build Failed. 1 errors, 0 warnings.
the following:
echo Skipping ${ProjName}; nothing to build
for:

For projects that use external resources located outside
of the application folder root (such as mtb_shared,
wiced_btsdk, or 3rd-party libraries), some IDE code
browsing and analysis features (such as resolving
includes or opening object declarations for objects and
headers located in those external resources) may not be
usable or show unresolved includes immediately after
project creation.
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Problem

Workaround

On macOS Catalina, some IDE GUI windows/elements
do not display correctly in some cases.

Resize the window or scroll to fix the display problem. In
some cases, use the Refresh option.
Cypress is investigating these issues and will address
them in a future release.

If you delete the shared library directory (named
mtb_shared, by default) from disk and then regenerate it
using make getlibs or the Library Manager, the
directory will not be restored properly for use in the
Eclipse IDE.

After regenerating the mtb_shared directory and
assorted libraries, open the Eclipse IDE and follow these
steps:
1. Delete the mtb_shared folder shown in the IDE
Project Explorer. Do NOT select the check box
"Delete project contents on disk" (if you do, you will
have to regenerate it again).
2. Select File > Import > C/C++ > Existing Code as
Makefile Project and click Next >.

This is because several files required by the Eclipse IDE
are not restored as they were when the application was
created.
Note You can delete the mtb_shared directory at any
time because it can be recreated. You might do this
when sharing the application, for example. The shared
library directory only contains files that are already
controlled and versioned, so you should NOT check it
into a revision control system.

3.
Some applications when imported into the Eclipse IDE
from Mbed OS fail to build with an error, such as:
cc1.exe fatal error: .mbed_config.h: No such file or
directory

a. Under Existing Code Location, click
Browse…, navigate to the application's root
directory, select the mtb_shared folder, and
click Select Folder.
b. Under Toolchain for Indexer Settings, select
ARM Cross GCC.
c. Click Finish.
After the import completes, build the application.

This happens because the application is generating a
path to the mbed_config.h header file that make build
system cannot find. Fix this by removing the relative
path '.\' in the makefile. Change this:
ASM_FLAGS += -include
ASM_FLAGS += .\mbed_config.h

To this:
ASM_FLAGS += -include
ASM_FLAGS += mbed_config.h

On Windows, when building a project and/or
programming the device, the IDE reports one or more
errors similar to the following:
*** fatal error - cygheap base mismatch detected 0x18032C408/0x18032D408
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This occurs because you likely have multiple versions of
Cygwin in your build environment path. The IDE uses a
version of Cygwin in the ModusToolbox installation
directory. Remove the instance of "C:\cygwin64\bin"
from your path.
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Problem

Workaround

Markdown (*.md) files do not render correctly in the IDE.
For example, tables do not show rows and columns.
Also, the IDE may show an error for the file such as:
"Cannot resolve element with id 'figure-1'".

This is a known issue with viewing markdown files in
Eclipse. Various rendering errors can be safely ignored.
Cypress recommends using an external editor, such as
Visual Studio Code or Typora to view markdown files.

When creating a new application, the IDE attempts to
open any found readme.md files. Occasionally (and
randomly), some of these files are opened in an external
text editor instead of in the IDE.

This appears to be an Eclipse bug with no workaround.
However, since *.md files do not render well in Eclipse
(as noted above), you should use an external editor,
such as Visual Studio Code or Typora, and set that
editor as the default.

Sometimes, the Eclipse "egit" plugin locks directories.
This prevents the Library Manager from removing
BSPs/libraries from these locked directories. When this
happens, you will see an error message in the Library
Manager console indicating that permission is denied for
removing a particular directory.

Before running the Library Manager from the Eclipse
IDE, right-click on the project and select Team >
Disconnect. When you are done with the Library
Manager, go to Team > Share Project and select the
correct project to reconnect.
Note Various projects may be set up differently, and the
process to use the Team options will vary as well.

The IDE Project >Build Configurations > Active menu To set Debug or Release mode, edit the project's
item to set Debug or Release mode is non-functional.
Makefile, which contains the following:
This is due to the project's Makefile.
# Default build configuration. Options
include:
#
# Debug
-- build with minimal
optimizations, focus on debugging.
# Release -- build with full optimizations
CONFIG=Debug

If you include external folders/files in your application,
the Eclipse IDE will occasionally unselect your
application project in the Project Explorer. However, it
will leave the Launch section populated with links in the
Quick Panel. Using those Launch links may result in a
reported error of "Could not resolve cy_prj_path."

To resolve this, click on the appropriate project for your
application in the Project Explorer, and then click on the
Launch link again.

Library Manager
Problem

Workaround

Issue using a VPN.

See Project Creator.

After running the Library Manager, the files shown in the
Eclipse IDE Project Explorer are not updated.

To see the updated files, click on the project in the IDE
Project Explorer and press [F5] to refresh the Eclipse
view.

Opening multiple instances of the Library Manager at
the same time for the same application could cause
confusion and indeterminate states in applications.

Do not open multiple instances of the Library Manager
for the same application. This issue will be addressed in
a later release.

Sometimes when you click Update in the Library
Manager, the tool will begin to process your request and
then appear to freeze.

Terminate the Library Manager and relaunch it. This
issue will be addressed in a future release.
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Problem

Workaround

When you remove a library item, the Library Manager
deletes the associated directory from the “libraries”
directory (typically this is called "libs"). On Windows, if
there are any processes that have a lock on that
directory, or a file in that directory, the directory removal
will not work completely. The Library Manager will
remove most of the directory contents and will also mark
the library item as removed.

To remove the library completely, you must release the
lock on the folder or file, and then manually delete the
directory. The steps to release the lock depend entirely
on the process that is holding the lock. Common
scenarios include:
•
A command-line prompt is in that directory. In
this case, "cd" to a different directory.
•
A text editor has a file from that directory open.
In this case, close the file in the text editor.
Depending on the text editor, you may have to
exit the entire text editor.
•
The Eclipse git "egit" plugin has a lock on the
folder. In this case, exit and restart the
ModusToolbox Eclipse IDE.
In all cases, once the lock is removed you must remove
the associated directory from the libraries directory
before the Library Manager will be able to work with that
particular library again.

Device Configurator
Problem

Workaround

The analog router may route across pins that are not
intended to be routed (either because they are digital
inputs, or because the project routes them in software).
This can cause signal corruption or other connection
problems.

Use the Analog Route Editor to manually route around
such pins, if necessary.

CapSense Tuner
Problem

Workaround

If using the UART communication interface, a low
packet-transferring rate may cause the CapSense Tuner
to disconnect due to a data-reading timeout error.

You can resolve this using either of these solutions:
• Increase the UART communication baud rate.
• Increase the value of the uartSingleReadTimeout
parameter available in the tuner INI file.
You can find the tuner INI file as follows:
• Windows:
<user_home>/AppData/Roaming/Cypress
Semiconductor Corporation/CapSense Tuner.ini
• Linux:
/home/<user_home>/.config/Cypress
Semiconductor Corporation/CapSense Tuner.ini
• macOS:
/Users/<user_home>/.config/Cypress
Semiconductor Corporation/CapSense Tuner.ini
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Documentation
Problem

Workaround

Various documents included with the release may
contain incomplete information, or may not contain upto-date screen captures or information.

New versions of documents, including this release notes
document, may be available online at:
https://www.cypress.com/products/modustoolboxsoftware-environment

Open Source
Portions of this software package are licensed under free and/or open source licenses such as the GNU
General Public License. Such free and/or open source software is subject to the applicable license
agreement and not the Cypress license agreement covering this software package. The applicable
license agreements are available online:
http://www.cypress.com/documentation/software-and-drivers/free-and-open-source-softwaredownload-page

Further Reading
There are several related documents provided with ModusToolbox software. These documents include
(but are not limited to):
◼

ModusToolbox Installation Guide

◼

ModusToolbox User Guide

◼

Cypress Programmer Release Notes

Other documentation includes (but is not limited to):
◼

Device Datasheets

◼

Application Notes

◼

Training

Contact your Cypress representative, as needed.
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